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The Anatomy of an Accessible Page
Syllabus 

DL 101 - INTRODUCTION TO ONLINE LEARNING 

Course Information: 
	 •  Course Title: Introduction to Online Learning 
	 •  CRN: 12345 
	 •  Credits: 3 
	 •  Term: Winter 2014

Instructor Information: 
Hello! My name is John Doe, and I’ll be 
your instructor for this course. I’ve taught 
this course online for the past two years. 
Each time I teach it, I learn something new.

Assignments/Assessments:

Grading Scale

Grade Scale By Points By Percentage

A 202 - 225+ 90 - 100%
B 180 - 201 80 - 89%

C (or P) 157 - 179 70 - 79%
D 135 - 156 60 - 69%

F (or NP) < 134 < 59%

Late Work & Make-up Policy
Assignments must be completed on time in order to earn full credit.
(Late assignments will earn 50% credit.)

Special Accommodations: 

Students who experience disability-related barriers should contact 
Disability Services (https://www.roanestate.edu/?5488-Disability-
Services ). If students elect to use approved academic adjustments, 
they must provide in advance formal notification from Disability 
Services to the instructor.

DL 101 - ONLINE LEARNING BEST PRACTICES
Best Practices when using complex graphics:
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When using complex images, include Alt text as you would 
for any other image but also include additional description 
as a caption. If more description is needed, include it in the 
content of the page.
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“Requiring use of an emerging technology in a 
classroom environment when the  
technology is inaccessible to an entire  
population of individuals with disabilities...
is discrimination prohibited by the
Americans with Disabilities Act of 1990
(ADA) and Section 504 of the Rehabilitation
Act of 1973 (Section 504) unless those
individuals are provided accommodations
or modifications that permit them to receive
all the educational benefits provided by
the technology in an equally effective
and equally integrated manner.”

Source: 6/29/2010
Dear Colleague letter sent to every college and university president
http://www2.ed.gov/about/offices/list/ocr/letters/colleague-20100629.htmle
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Web Accessibility
Required by Federal Law

Web Accessibility at Roane State Community College

1

Adhering to web accessibility guidelines while developing
your online course will benefit all students, including those
with visual, hearing, mobility and learning disabilities.

RSCC Web Accessibility Guidelines

The RSCC Accessibility Guidelines for Online Course 
Content, are based on the internationally accepted Web 
Content

Accessibility Guidelines AA standards (WCAG 2.0).*
This handbook is a reference guide. For more information,
visit http://ctat.roanestate.edu/accessibility-in-online-cours-
es-new/
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WEB Accessibility Guideline

Component Guideline Why is this Important?
Use properly formatted 
headings to structure a page.

Format lists as proper lists.

Use sufficient color contrast.
Don’t use color alone to convey 
meaning.

Ensure that any action that uses
a mouse can also be completed
using only the keyboard.

Provide alternative (Alt) text
descriptions for images.

Headings help to organize content, making it easier for everyone to read. Headings are also a 
primary way for people using screen reading software to navigate a page of text.

Formatting is conveyed to assistive technologies and mobile devices so they can present infor-
mation as it’s meant to be presented. Properly formatted documents are more understandable 
and accessible.

Without sufficient color contrast between font and background, people who are color
blind and low vision will not benefit from the information. And using color alone to convey mean-
ing will leave those who are color blind or blind unable to interpret the meaning.

Mobility and visual disabilities often make using a mouse impossible or ineffective. If content is 
not keyboard accessible, it will limit who can learn from the content.

Alt text is read by a screen reader. It should adequately describe what is being displayed and 
why it’s important. This allows screen reader users to benefit from the information being 
conveyed by the image, even if they cannot see it.

HEADINGS

LISTS

LINKS

TABLES

COLORS

KEYBOARD

IMAGES

Write meaningful link text.

•	 Why Column Headers in a Data Table are Important
	 Using table headers is important to conveying tabular data accurately.
•	 Why the Reading Order in a Table is Important
	 Screen readers read tables from left to right, top to bottom, one cell at a time (& only once).
	 If cells are split or merged, it could throw the reading order off which may make the table difficult 	
	 to comprehend by users who are blind & using a screen reader to navigate.

Create tables with column 
and/or row headers, and en-
sure a proper reading order.

Links embedded in text should describe the link’s destination. This helps all users 
navigate more efficiently, especially screen reader users.
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WEB Accessibility Guideline

Component Guideline Why is this Important?

NAVIGATION

BLINKINGS

FORMS

VIDEO

AUDIO

SOFTWARE

MATH & 
SCIENCE

Design clear and consistent

Eliminate or limit blinking /
flashing content to 3 seconds. 

•	 Label form fields and buttons
 	 clearly.
•	 Ensure a proper logical 
	 reading order in a form. 

All video should be captioned/
subtitled.

All audio should be transcribed. 

Require only accessible 
software & applications. 

Write math and science
equations accessibly. 

Clear and consistent navigation will allow students to focus on your content
rather than on how to find it. 

Blinking content is distracting, and it can cause seizures to occur in people with
a photosensitive disorder. 

•	 Why the reading order of a form is important
	 Using the tab key, your cursor should follow through the form in the same order it is intended
	 to be completed. This benefits users who cannot use a mouse.
•	 Why labeling buttons and form fields is important
	 A screen reader will identify the button or form field by reading the label. The label should 		
	 adequately describe the button’s action, and the form field label should indicate what information
	 should be filled in to the form field. 

Video captions benefit many viewers. Captions are essential for those who are deaf and hard
of hearing, but they also aid in comprehension for non-native English speakers, those who are
unfamiliar with vocabulary, and viewers with some learning disabilities or in a noisy
environment. 

Audio transcripts benefit many students. They are essential for those who are deaf or hard
of hearing, but they also assist anyone who would like to read or search the transcript.

Inaccessible software and applications will shut students with disabilities out. 

For web pages, use an equation editor that outputs MathML. For MS Word and PPT 
documents, use the MathType plugin. 



Page Templates

Headings

Images

Lists

Links

•	 Use the Simple Bootstrap 
	 page template.

•	 Properly format headings.
•	 Use headings in the correct 
	 order.

•	 Add alternative (Alt) text to 
	 images.

•	 Format a list as a list using 
	 Ordered or Unordered lists.

•	 Write meaningful link text 
	 that indicates the link's 
	 destination

•	 When creating a File, Select a Document Template of Simple Bootstrap, then edit the content.  
	 (Recommendation: Type your content out accessibly in a Word doc and paste it in the 
	 Simple Bootstrap templated D2L page.)

•	 Highlight the text and select the Heading # from the Format drop-down menu on the tool bar.
•	 There should be only one Heading 1 (h1) per page. But there can be multiple h2, h3, h4, 
	 h5, h6. DO NOT skip heading levels.

1.	Place the cursor where you want to insert an image, and click the Insert image icon from the 	
	 toolbar. The Add a File window will open.
2.	Browse to the image location and select the image file. Click Add button.
3.	The Provide Alternative Text window will open. Describe the purpose of the image in the 
	 Alternative Text field, or check the box if the image is just decorative.
4.	Click OK.

1.	Select the content you want to make into a list.
2.	From the toolbar, click the Unordered/Bulleted list icon if the order 
	 doesn’t matter. Select Ordered List from the drop-down menu 
	 (next to the bulleted list icon) if the order does matter. 

1.	Highlight meaningful text for the link (ex. Pellissippi State) 
2.	From the toolbar, click on the Insert Quicklink icon .
3.	Select URL in the Insert Quicklink window

•	Type in the URL (http://www.roanestate.edu).
4.	Click the Insert button. 

3A

Component Guideline How to make it Accessible

HOW TO MAKE

Accessible D2L Web Pages



Component Guideline How to make it Accessible

Tables

Color

Math&
Science

Multimedia

•	 Indicate column (or row) 
	 headers.

•	 Add table caption.

•	 Check the reading order.

•	 Use sufficient color 
	 contrast.

•	 Don't use color alone to 
	 convey meaning.

•	 Write math and science 
	 equations using MathML.

•	 Eliminate or limit blinking/flashing content to 3 seconds.
•	 Make sure all mouse actions can also be completed with a keyboard alone (without a mouse.)
•	 Use an accessible media player like YouTube.

1.	Select each cell to be marked up as a row or column header
2.	Click on the drop-down menu next to the Table icon in the toolbar.
3.	Choose Cell Properties. The Table cell properties window will open.
4.	 In the Cell Type field, click on the drop-down list and select Row Header or Column Header.
5.	Click Update when done. 

1.	Select the text that you want to change to another color.
2.	Click drop-down menu next to the Apply Color icon in the toolbar.
3.	Select the color.

Note: When picking a color for your text in D2L, make sure you choose a color that registers with 
a green checkmark for WCAG AA in the Select a Color palette 

•	 Don’t use color alone to make a distinction, a comparison or to set something apart from the rest of 	
	 the web page. If you categorize something by color alone, those who are color blind or blind will not 	
	 benefit from the color distinction.

Use the D2L equation editor.
For more information, go to the Math & Science page in this handbook.

•	 A screen reader reads tables from left to right, and top to bottom, never repeating a cell.
•	 Merged, nested, and split cells may alter the reading order of a table.
•	 Make sure you construct your tables in a way that accommodates a good reading order.

1.	Select the table and click on the drop down menu next to the Table icon.
2.	Select Table Properties, and check Include Caption.
3.	Click Update when done and type your caption in the table cell created.

3B

HOW TO MAKE

Accessible D2L Web Pages



HOW TO MAKE

Accessible PowerPoints

4A

Component PowerPoint
Outline View
•	Check the outline view.

Slide Layout
•	Use the PPT provided slide 	
	 layouts when building slides 	
	 to help your slide’s reading 	
	 order remain intact. 

Reading Order
•	Ensure the tab
	 order = the reading order

Images
•	Add alternative (Alt) 
	 text to images and 
	 shapes.

Lists
•	Format a list as a list.

1.	Click View tab. 
2.	 In the Presentation Views group, click Outline View.
3.	 In the Outline panel, make sure all text from the slides 
	 appears in the Outline View.

•	 From Home tab, choose the New Slide 
	 drop down menu and select a slide template. 
	 (Don’t use the Blank slide template.)

1.	On the Home tab, click on Arrange and choose Selection Pane. 
2.	To see the reading order of the slide, tab through the slide and 
	 the corresponding element will highlight.
3.	To re-arrange the reading order, click arrow up/down button on 
	 the Selection Pane (Mac: drag layers.) Bottom layer is read first.
4.	Test reading order with the Tab key again.

1.	Right click on the image and select Edit Alt Text (Mac: Right 
	 click on the image and select Format Picture. Under the Layout 
	 and Proporties tab, select Alt Text.)
2.	Enter appropriate alt text or mark as decorative. (Mac: Write a 
	 description for the image in the Description field. Don't use the 
	 Title field.)

1.	Select the text to make into a list and click on the Home tab. 
2.	 In the Paragraph group, select the Numbering or Bullets icon.
	 Use Numbering lists if a sequential order is important.
	 Use Bullets lists if all items are of equal value.

Save your original files. You may need them if you have a student who needs alternative formats.

corderz
Inserted Text
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HOW TO MAKE

Accessible PowerPoints
Component PowerPoint

Links
•	Check the outline view.

Tables
•	Check the reading order

Color
•	Use sufficient color 
	 contrast.

Math & Science
•	Use MathType to
	 write Math equations.

Video & Audio

•	 Indicate column headers 
	 for data tables.
Note: A table in Slide Show 
view is not accessible. Use 
Alt text.

•	Don't use color alone to 	
	 convey meaning.

1.	Type out text that describes the destination of the link (e.g., PSCC Homepage).
2.	Select the text, right click & choose Link (Mac: Hyperlink) from the menu.
3.	The Insert Hyperlink window will open. Enter a URL address in the Address 
	 field (e.g., http://www.pstcc.edu) 
4.	Click the OK button to save the link.

•	 A screen reader reads a table from left to right, & top to bottom (never repeating a cell.)
•	 Merged, nested, and split cells may change the reading order of a table.
•	 Construct your table in a way that accommodates a good reading order.

1.	Place the cursor in the top row of your data table.
2.	Click the Table Design tab.
3.	 In the Table Style Options group, select the Header Row check box.
4.	The cells in the top row of your table make up the column headers.

•	 Use enough color contrast between the text (i.e. black color) and the background color (i.e. white color).
•	 Without sufficient color contrast, people who are low-vision and color blind will not benefit from the information.

Don’t use color alone to make a distinction. If you categorize something by color alone, those who are color blind or blind won’t benefit 
from the information.

Use the MathType plugin http://www.dessci.com/en/ for MS Word to create math
and science equations, formulas and notations. (DO NOT use MS equation editor.)

Don’t embed the video, instead, link out to videos.

Save your original files. You may need them if you have a student who needs alternative formats.

Live 
Presentations

Use PowerPoint's auto captioning feature.
1.	Select the Slide Show tab and check the Always Use Subtitles checkbox.
2.	Review the Subtitle Settings.



HOW TO MAKE ACCESSIBILE

Word Documents
Check Word Document

5A Save your original files. You may need them if you have a student who needs alternative formats.

Headings
• Properly format

headings.

• Use headings in
the correct order

Images
• Add alternative (Alt)

text to images

Lists
• Format a list as

a list

Links
• Create a link that

describes its
destination

Math
& Science

1. Select the text that you want to make into a heading.
2. Go to the Home tab.
3. Choose the appropriate heading level from the Styles group.

Heading 1 should only be used ONCE per page. Heading 2, 3, etc. can be used multiple times. (DO NOT skip heading levels!.)

1. Select the text that you want to make into a list.
2. On the Home tab, in the Paragraph group, select the Bullets or

Numbering list.

1. Type out text that describes the destination of the link (e.g., RSCC
Homepage).

2. Select the text, right click & choose Link (Mac: Hyperlink) from the
menu.

3. The Insert Hyperlink window will open. Enter a URL address in the
Address field (e.g., http://www.roanestate.edu)

4. Click the OK button to save the link.

• Use the MathType plugin http://www.dessci.com/en/ for MS Word
to create math and science equations, formulas and notations.
DO NOT use Microsoft’s equation editor.

1. Right click on the image and select Edit Alt Text (Mac: Right click
on the image and select Format Picture. Under the Layout and
Properties tab, select Alt Text.         )

2. Enter appropriate Alt text or mark as decorative. (Mac: Write a
description for the image in the Description field. Don't use the
Title field.)



HOW TO MAKE ACCESSIBILE

Word Documents

5B Save your original files. You may need them if you have a student who needs alternative formats.

Check Word Document
Tables
•	 Indicate column 
	 headers for data tables.

•	Check the reading 	
	 order

Color
•	Use sufficient color 	
	 contrast.

Forms
•	Label form fields & 	
	 buttons.

•	Check the reading 	
	 order of forms.

•	Don't use color alone  
	 to convey meaning.

1.	Place the cursor in the top row of your data table.
2.	Click on the Table Design tab.
3.	 In the Table Style Options group, select the Header Row check box.
4.	Under Table Tools, click the Layout tab.
5.	 In the Data group, click the Repeat Header Row button. This will indicate the top 	
	 row as the table’s header. 

•	 Screen reader reads a table from left to right/top to bottom (never repeating a cell.)
•	 Merged, nested, and split cells may change the reading order of a table.
•	 Construct your table in a way that accommodates a good reading order.
•	 To test the reading order, place your cursor in the first cell of the table. On the keyboard, press the Tab key repeatedly to navigate through  
	 the table. This will be the reading order that technologies will use.

•	 Use enough color contrast between the font and its background colors.
•	 Without sufficient color contrast, people who have low-vision or are color blind will not benefit from the information.

•	 Don’t use color alone to make a distinction. If you categorize something by color alone, those who are color blind or blind will not be able 		
	 to benefit from the information.

•	 Press the tab key repeatedly to check the order a screen reader would navigate through the form. If it doesn’t land on the form fields in the	
	 correct order, you will need to edit the form.
•	 The tab order (or reading order) is important to those who are blind or physically disabled and rely on keyboard access.

•	 Use a form template to create a form. 

•	 Use real text labels for form fields and alternative text for buttons. 



HOW TO MAKE

Accessible PDFs

Convert MS Office
to an Accessible
PDF document

Run Adobe Acrobat
Built-in
Accessibility
Checker 

•	 Microsoft Office

•	 Adobe Acrobat Professional
(Version Pro DC)

•	 Adobe Acrobat Professional
(Version Pro DC)

•	 All versions. No matter what you
are converting to PDF, it’s
important to save your original
files in case a student needs an
alternate format. 

1.	Start with an accessible word document or presentation.
2.	Click the Acrobat tab (if you have one) and select Create PDF. Or choose Save As a PDF 	
	 format before clicking Save, click on the More options link.
3.	Enter a file name in the File name (Mac: Save As) field. (For Mac: This is the last step.)
4.	Click on Options button. (This step & the following steps are not available on Mac version)
5.	 If you saved using an Acrobat tab, make sure Enable Accessilbility and Reflow with 		
	 tagged Adobe PDF is checked. If you saved using Save As, make sure Document 		
	 structure tags for accessibility is checked AND Bitmap text when fonts may not 
	 be embedded is UNCHECKED..
6.	Click OK and Save. This will tag all of the text formatting, so page headings and lists are

correctly interpreted by a screen reader.

Method Software/Hardware How to Make it Accessible

6 Save your original files. You may need them if you have a student who needs alternative formats.

1.	Open the scanned PDF file.
2.	 In Tools, open Scan and OCR.
3.	Click Scanned Document under the Enhanced menu.
4.	Check the box for Recognize Text.
5.	Click the Enhance button.

1.	Open the Accessibility tool under the Tools tab.
2.	Select the Full Check button.
3.	The Accessibility Checker window will open.

•	 Under the Report Options, check on the Create Accessibility Report.
•	 Under the Checking Options section:

•	 Category: Document and check all the items.
4.	Click the Start Checking button.
5.	The Accessibility Checker Report will display on the left pane.
6.	Right click on the bolded issues and choose Fix, if available, or Explain.”

Run Optical Character
Recognition (OCR) on 
scanned document



HOW TO MAKE

Accessible Video & Audio

Component Best Practices How to Check Accessibility

Media Player
The buttons need to be properly
labeled so a screen reader user 
can operate the player.

Captioned Media
Use captioned/subtitled media 
for videos shared on campus 
websites, in open forums and in 
course content.

Keyboard Navigation

It is important to accessibility that 
students can access and operate a 
media player with the keyboard alone 
(not using a mouse).

The PSCC ERC/Library has a wide 
selection of captioned media. Check 
with your Subject Librarian. 

Search for captioned media 
on YouTube.

Make sure the YouTube video you 
use does NOT have Auto-generated 
captions.

To test for keyboard accessibility, press the Tab key to navigate to the player,and use 
the Tab, Arrow keys, Enter, and Spacebar to interact with the media player buttons. 

How do I find human transcribed captioned videos on YouTube? 
(Search from YouTube site)

1.	Enter your search keyword in the YouTube Search field.
2.	Add a: , CC (a comma, CC)
3.	Press Enter or click the magnifying glass icon.

How do I know?
•	 Click the Settings button and check the 
	 Subtitles field. Avoid auto-generated 
	 subtitles and the Translate feature 
	 which are not usually accurate. 

7 Save your original files. You may need them if you have a student who needs alternative formats.



A B C

Month
Hours in varied latitudes

20° 30° 40° 50° 60°

Mar 12 12 12 12 12
Apr 12.3 13.2 13.5 14 17.5
May 12.9 13.7 14.3 15.5 17.7
Jun 13 14 14.9 16.1 18.2
Jul 12.8 13.8 14.2 15.7 17.8
Aug 12.5 12.8 13.2 14 15
Sep 12 12 12 12 12
Oct 11.6 11.2 10.8 10 9
Nov 11 10.2 9.7 8.3 6.5
Dec 10.9 10 9.1 7.9 5.7

Figure 9

Example of Data Table for 
Figure 9

<html>
<p>Modeling 
amount of daylight 
as a function of time 
of year Figure 9 
shows graphs of the 
number ofhours of 
daylight...</p> 
</html>

Figure 9

fig9-longdesc.html

HOW TO MAKE

Accessible Complex Images
Complex Images include graphs, charts, diagrams, maps, and illustrations. Below are 3 ways to provide alternative (alt) text-based 
description for complex images, when a simple alt text attribute is insufficient. Choose the best Alt text method for your image types.

Use a Caption Describe in Surrounding 
text

Link out to a web page 
with a longer description

For Web Pages: Your caption must be associated
with the image, so make sure to properly add a 
caption using the ‘figcaption’ html tag. (Requires 
HTML editing).
Note: For MS Word and PowerPoint: Right click on 
the image and select Add Caption.
Example Code:
<figure><img src=”images/fig9” alt=””
width=”160” height=”120” />
<figcaption><em>Caption goes here,
Fig.9-Graph..</em></figcaption></figure>

Fig.9 - Graph of the length of daylight from March 
through December at various latitudes. For example, 
at 40 degree latitude there are 12 hours of daylight 
in March. In October, there are 10.8 hours of day-
light at 40 degrees.

If the image is adequately described in surrounding text
(including text-based data tables), so that the image is
just reinforcing the text, no further description is needed.
Example:
Modeling amount of daylight as a function of time of
year, Figure 9 and the table beside it, show the number
of hours of daylight as functions of the time of the year
at several latitudes, from March through December.

If the image cannot be described using methods A or B, 
use the ‘longdesc’ attribute (Requires HTML editing).
Example code:
<img src=”images/fig9.jpg” alt=”Fig.9-
Graph of the length of daylight from
March 21 through December 21 at various
latitudes.” width=”400” height=”290”
longdesc=”fig9-longdesc.html” />

8A The graph image is from Lucia C. Harrison, Daylight, Twilight, Darkness and Time (New York: Silver, Burdett, 1935) page 40.



HOW TO MAKE

Accessible Complex Images

A 3D model of chest anatomy

Indicate if a model is available

If you know where a 3D model of the image
is available, indicate that in your image caption
or on the same page as the image.

Resources 
for Image Description Tactile Representations

•	 NCAM: Guidelines for Describing STEM (Science
Technology Engineering and Math) images
(https://tinyurl.com/alt-stem )

•	 Art Beyond Sight: How Do We Access Meaning in Art?
(Describing art images in alt text) - (http://goo.gl/dAXZOx)

•	 Video: How to Describe Complex Images for 
Accessibility (From Diagram Center’s Webinars) 
https://www.youtube.com/watch?v=oSdz6KZpLjs

•	 Diagram Center: Accessible Image Sample Book
http://goo.gl/N0arvW 

8B

Sometimes touching a model or a tactile graphic is the best way to describe something.

Tactile graphics
Tactile graphics have different sized raised dots to show variation in graphs, charts and maps.

Example:
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HOW TO MAKE

Accessible Math & Science

Save your original files. You may need them if you have a student who needs alternative formats.

Component MathTools Best Practice

Math & Science 
equations,  
formulas  
and notation

•	 MathML

•	 D2L

•	 Word documents

•	 PDFs

•	 PowerPoints

•	 LaTex

•	 Graphs

MathML stands for ‘Math Markup Language’ which is the web standard for accessible online math and science 
notation/equations/formulas. Typically, a user does not create MathML, but instead uses a conversion process to 
output MathML. 

We recommend that as much of the online class as possible be conducted within D2L. All output from D2L’s 
equation editor is stored as MathML, which is screen reader-accessible.

MathType is an equation editor created by Design Science that is compatible with MS Word for Windows and Mac. 
Together, MS Word with MathType can be exported as MathML or it can be converted to braille. DO NOT use 
Microsoft’s equation editor.  

Math IS NOT accessible in PDF. Save the original file with the original MathType or LaTeX equations in case of an 
accommodation request. 

For MS PowerPoint, use the MathType plugin to create math and science equations, formulas and nota- 
tions. DO NOT use Microsoft’s equation editor. If you convert to a PDF or export to a webpage, save your original 
MS PowerPoint files in case of an accommodation request.

To make graphs accessible, do your best to describe them using alternative text, long descriptions, or captions. 

LaTeX is a mark-up language. Converting LaTeX documents into an accessible format is usually straightforward. 
Keep LaTeX original files if you convert to other formats.



Component Best Practice

LINKING TO

Third Party Online Materials

How accessible 
are their digital 
materials?

•	 Are the videos captioned and audio recordings transcribed?
There should be transcripts for audio recordings and captions or subtitles for video. If they aren’t available, ask the publishing represen-
tative when they plan to have them. If they have no plans, ask them to give RSCC written permission to transcribe or caption the media 
when there’s an accommodation need.

•	 Are images described in alternative text?
PowerPoint slides from publishers often have images without any alt text. Ask your publishers if their images have alt text.

•	 Can all of the text that is displayed on the screen be read aloud by text-to-speech software?
Screen readers (assistive technology used by people who are blind) read real text. They cannot read images of text or text embedded in 
Flash animations/movies/simulations.

•	 How accessible are the E-books?
Are the images described? Are embedded objects like videos keyboard accessible and captioned? Is the E-reader keyboard and screen 
reader accessible? 

•	 Can all interactivity (media players, quizzes, flashcards, etc.) function using only the keyboard (no mouse)?
People who are blind or have upper mobility disabilities cannot use a mouse. They use the keyboard to navigate and interact on the 
Web. It is required that any interactive elements on a publisher’s website be operable by keyboard alone if they are used in your course.

•	 Is there any documentation available (VPAT or White Paper for example) that confirms accessibility or usability testing results?
A VPAT (Voluntary Product Accessibility Template) is used by many organizations to report the level of accessibility of software products.

•	 Is your multimedia (Adobe) Flash or (Oracle) Java-based? Can your materials be watched on mobile devices?
Content created in Flash or Java can be inaccessible and may not run on mobile devices and tablets.

Open Educational 
Resources (OER)

10

•	 OERs have the same accessibility requirements as all other digital materials. However if they are not accessible, they can usually
be made accessible, unlike materials that reside on a publisher’s server. Plus OERs are usually free to students!
Check out: http://ctat.roanestate.edu/open-educational-resources-oer/



AUTOMATED

Accessibility Checkers

Software Tools How to Check
MS Office

(Word,
PowerPoint, Excel) 

PDF
(Adobe Acrobat 
Professional

D2L Brightspace

•	 A built-in accessibility checker

(Note: The accessibility checker 
only checks .docx, .pptx and 
.xlsx files)

•	 A built-in accessibility checker
(Tools>Accessibility)

•	 Brightspace is an accessible 
	 LMS platform. It also has a tool 	
	 to check the accessibility of the 	
	 content.

1.	Go to the File tab.
2.	Select Info from the sidebar menu.
3.	Click on the Check for Issues button.
4.	Select Check Accessibility from the drop-down list.

The Accessibility Checker panel will open to the right of
the document. The accessibility checker provides you with a list of
errors, warnings & tips. When you click on an error or warning,
instructions on how to fix it appear below in “Additional Information”. 

1.	Select the Tools tab to Add the Accessibility Tool to the panel on the right.
2.	Select the Full Check button & the Accessibility Checker Options will open.

•	 On the Report Options section, check on Create Accessibility Report .
•	 On the Checking Options section: select Document under Category  
	 field, and check all items.

3.	Click on the Start Checking button and the Accessibility Report will display.
4.	Right click on the bolded issues and choose Fix, if available, or Explain.
 

1.	 In a Content page, add your text and images.
2.	While still in edit mode, click the Check Accessibility link at the bottom 
	 right corner of the Content editing window.
3.	The Accessibility Checker will open with the results of the accessibility check of your content.
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Instructors
RESPONSIBILITIES

Distance Education (DE)
RESPONSIBILITIES

Disability Services (DS)
RESPONSIBILITIES

WHO’s Responsible for Accessibility of Online Courses?

Instructors, Distance Education and Disability Services
Test the accessibility of software and web apps used in online courses.
Develop Accessibility Plans proactively when barriers are found.
Work together to identify and implement appropriate accommodations when barriers are encountered.

As the subject matter expert and the course  
developer, an instructor:

•	 Designs clear and consistent navigation.
	 Writes alternative text descriptions for images.

•	 Creates documents using accessibility guidelines 	
	 (http://ctat.roanestate.edu/accessibility/).

•	 Retains original files (PowerPoint, Word, etc.)

•	 Uses captioned media whenever possible.

•	 Writes math and science with MathML (D2L 
	 equation editor), LaTeX, MathType or Libre Office.

•	 Checks accessibility of required software & web 	
	 applications used in course at http://ctat.roanestate.
edu/accessibility/.

•	 Supplies DL and DS with course materials upon 	
	 request for an accommodation.

•	 Prepares Accessibility plans for inaccessible 
	 content.

As the online course development facilitator
and faculty resource, Distance Education (DL):

•	 Provides media captioning for DL course  
	 accommodations.

•	 Assists DS with retrofitting course material for 
 	 timely accommodation.

•	 Offers training sessions (F2F & Online) &  
	 over-the-shoulder assistance.

•	 Develops training materials (Accessibility  
	 Guidelines Handbook & Quick Guide).

•	 Reviews courses for accessibility & provides  
	 feedback & support to instructors.

•	 Supports Accessibility Plan development to  
	 proactively address course barriers.

•	 Facilitates subject area accessibility studies.

•	 Maintains pcc.edu/access website with how-to 	
	 video tutorials and step-by-step instructions. 

As a student & faculty resource, with expertise in alt 
formats and assistive technologies, DS:

•	 Increases awareness of the disability experience & 		
	 works with staff & faculty to proactively reduce 
	 barriers by
	 Hosting open events,
	 Offering drop-in hours, & individual consultations.

•	 Reviews documentation of disability & determines 		
	 student eligibility for accommodation.

•	 Leads efforts to ensure students are appropriately 		
	 accommodated.
	 Notifies faculty & DL when an accommodation is 
		  required.
	 Supplies students with an accessible format of the 	
		  textbook.
	 Provides alternative format of PDFs, math/science 
		  and publisher PPTs
	 Administers other reasonable auxiliary aids & 
		  services.
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ACCESSIBLE 

Training & Support
 

	 Accessibility Training
	 Check the Accessibility Website for how-to instructions and video tutorials. 
	 http://ctat.roanestate.edu/accessibility/

	 Faculty Help Desk 
	 Email: help@roanestate.edu(865) 354-3000 ext. 4357 
	 Phone: (865) 354-3000 ext. 4357

	 Instructional Support 
	 https://ctat.roanestate.edu 
	 Email: ctatmailbox@roanestate.edu 
	 Phone: (865) 882-4556 

	 Questions about accessibility?
	 Susan Sutton......................................(865) 882-4658...........................suttonsr@roanestate.edu
	 Misty Anderson.................................(865) 354-3000 ext. 4717........andersonme1@roanestate.edu
	 Zach Corder........................................(865) 354-3000 ext. 4915........corderz@roanestate.edu

Original design by: SUPADA AMORNCHAT / Editor: MATTHEW WARD for RSCC version

Testing Tools
•	 WEB PAGES: WAVE TOOLBAR 

https://wave.webaim.org/

•	 D2L BRIGHTSPACE: Built-in 

•	 MS WORD: Built-in 

•	 MS PPT: Built-in 

•	 PDF: Built-in Adobe Acrobat Pro

•	 COLOUR CONTRAST ANALYSER 
https://www.paciellogroup.com/ 
color-contrast-checker/
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